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Optec Focuser
Connect to the Optec TCF focuser from the Focuser menu. The focuser is cabled to 
your Mac by means of a USB/Serial adaptor and the Optec PC serial port converter 
and cable. Select your focuser model (S or S3) from the Control tab. 

From the control tab you can move the 
focuser in and out at various speeds or 
set it to a particular position. You can 
set the focuser to the A or B tempera-
ture compensation modes. The current 
position and temperature are always 
displayed at the bottom of the window. 

From the Auto Focus tab you can cal-
culate the best focus position. First, fo-
cus as accurately as you can manually. 
Once you have a reasonably good focus 
in the image, make sure you are on the 
Auto Focus tab in the Optec panel and 
click on a star. A small focus window 
will be exposed centered around your 
click point. You should choose a star 
and exposure such that the star will not 
saturate at the best focus and the star is 
not near any other bright stars.

The Samples menu sets how many im-
ages to take at each focus position. The 
Images menu sets how many different 
focus positions to use and the Steps 
value sets how many focuser steps to 
move between images. 

To start the auto focus process hit 
the Start button. This will move the 
focuser inward by half the total move-
ment range. Images will be taken and 
the focuser will be moved until all 
the images have been recorded. The 
graph should show a curve similar to 
the example here. If you do not end 
up with a curve you may have to start 
the sequence over again from a differ-
ent starting focus position. The Steps 
value should be large enough to clearly 
record variations in focus. Once the 
exposure sequence is complete a curve 
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fit routine will run and the best focus position will be calculated. Hit the Set Focus 
button to move the focuser to this position. 

A sigma 2 level RMS error value will be calculated. As long as the error value is 
within the critical focus zone (CFZ in steps) for your telescope, you are at best focus. 
You may want to try different Samples, Images and Steps settings to get the lowest 
RMS error possible.

Note: The auto focus functions have to take control of the SBIG camera, so you can 
not be autoguiding or using the camera for other purposes while auto focusing.

The Temp tab allows you to moni-
tor and control the Optec temperature 
compensation functions. You need to 
establish your best focus first. Select ei-
ther mode A or B and then hit the Learn 
button. To save the start learn data hit 
the Learn Data Save button. After your 
scope cools by several degrees you can 
run the auto focus routine again and 
then hit the Calc button to calculate the 
slope data. Each time you do this an 
average slope value is calculated. You 
can also enter a slope value manually 
if you know what it should be. You can 
send either the current calculation or 
the average value to the Optec focuser 
with the Send buttons. 

Once you have a good slope value and 
have sent it to the focuser you can turn 
on automatic temperature compensa-

tion by selecting the mode (A or B) from the Control tab. Do NOT use the mode 
switch on the Optec hand controller. However, if you disconnect from the focuser you 
can use the mode switch on the Optec hand controller instead.

You can close the Optec panel with the panel’s close button or with the Panel menu 
item. The Optec controls are still running. The Panel menu item will display the 
Optec panel again. The Optec menu item will disconnect the Optec focuser. The 
Optec focuser can generate a lot of serial traffic so once the learn data is established 
and saved it is usually a good idea to disconnect from the Optec. At the end of the 
evening you can reconnect, run the auto focus again, restore the learn data and cal-
culate the slope with a maximum temperature change. Send the slope to the Optec 
before disconnecting again.

Be sure to select Manual from the Control tab before you disconnect from the Optec 
or want to use the focuser’s hand controller.
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Robo-Focus Focuser
Connect to the Robo-Focus focuser from the Focuser menu. The focuser is connected 
to your Mac by means of a USB/Serial adaptor and the RS-232 connecting cable. 

From the Control tab you can click 
on the IN and OUT buttons (click on/
click off) to move the focuser. The 
GOTO button will move the focuser 
to the entered position. The indicator 
bar shows the relative position of the 
focuser from 0 to the Max Step value. 
Note: backlash is not applied with the 
In/Out buttons.

The Robo-Focus configuration set-
tings are displayed in the Setup box. 
When you enter new values they will 
be stored in the Robo-Focus. See the 
Robo-Focus manual for information 
about these values.

The Auto Focus controls operate in 
an identical way to the Optec focuser. 
See the Optec focuser section in this 
manual for instructions.

From the Temp/Relay tab you can es-
tablish automatic temperature compen-
sation and control the Remote Power 
Module if you have one.

To enable automatic temperature com-
pensation you need to establish your 
best focus first. Hit the Learn button 
and the current focus position and tem-
perature will be saved. After the tem-
perature has dropped several degrees 
refocus and then hit the Calc button. 
The temperature compensation slope 
value will be calculated. Choose an 
update rate and check the Auto Temp 
box to start automatic temperature 
compensation. The slope value will be 
saved and unless you change scopes 
or optics you will not have to run the 
Learn sequence again.
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JMI Smart Focus
Connect to the JMI Smart Focus from the Focuser menu. The focuser is connected to 
your Mac by means of a USB/Serial adaptor and the RS-232 connecting cable.

From the Control tab you can click on 
the IN and OUT buttons to start focus-
er movement or enter a value and hit 
the Goto button to move the focuser. 
Hit the Stop button during movement 
and the focuser will stop (without 
backlash). The IN and OUT buttons 
do not apply backlash. The indicator 
bar shows the relative position of the 
focuser from 0 to the Maximum value. 

The three slider controls allow you to 
adjust the focuser speed. The slow (S) 
slider adjusts the speed when a goto 
movement is close to the target posi-
tion. The fast (F) slider adjusts the 
speed when a goto movement is far 
from the target position. The IN/OUT 
(I/O) slider adjusts the speed when the 
IN or OUT buttons are selected.

The Setup area has controls to es-
tablish the zero point, maximum value and backlash amount. Read the JMI manual 
before you hit the Initialize button. It is very important to establish the correct zero 
point and maximum value before you operate the focuser, and this must be done at 
least once or Equinox 6 will not be able to accurately move the focuser.

The Auto Focus controls operate in an identical way to the Optec focuser. See the 
Optec focuser section in this manual for instructions. The JMI Smart Focus does not 
have temperature compensation.
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Optec Pyxis
The Optec Pyxis field rotator allows you to rotate the camera to any angle. This can 
be very useful if you are controlling your telescope and camera remotely. 

Once you power the Pyxis it runs a 
homing routine and will not respond 
to commands until that is completed. 

The Get PA button will read the 
current position angle. Angle values 
range from 0° to 359° where 0° is 
north, 90° is east, 180° is south and 
270° is west.

To rotate the camera to a desired po-
sition enter the angle in the Enter PA 
edit box and hit the Move button. 

The Home button will tell the Pyxis 
to run its homing routine and go to 
angle 0°.

The default rotation direction is 
clockwise. If your optics require 
you to reverse that direction you can 
uncheck the Move CW checkbox.

If your scope mount is Alt/Az you will get the best tracking for imaging by using a 
wedge. With an Alt/Az mount the image will suffer from field rotation throughout the 
exposure. If you have to keep your mount in Alt/Az the Pyxis can compensate for this 
field rotation. However, the amount of field rotation depends on your location (site), 
the time and where your scope is pointing - and this information needs to be updated 
during the exposure. 

To do this you must have Equinox 6 running and controlling your scope. The Read 
Data button will get the required information from Equinox 6 and enable the Start 
button. To begin the field rotation compensation hit the Start button. You can keep 
this running for multiple exposures as long as you don’t change the scope’s tracking 
location. The scope data will be automatically updated once a minute.

If you are using the Pyxis 3 device you must check the Pyxis 3 checkbox. The gear-
ing for the Pyxis and Pyxis 3 are different so the field rotation calculation needs 
to know which device you are using. While you are running the field rotation you 
should not send any other commands to the Pyxis. When you stop the field rotation 
the current PA value will be in error so you need to run the Home routine.
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Equinox 6
Equinox Image and Equinox 6 can talk to each other if both are running at the same 
time. Equinox 6 can supply scope information to Equinox Image and Equinox Image 
can supply SBIG camera information to Equinox 6.

Equinox 6 can display an SBIG outline in the Scope View window if it knows what 
camera is being used. Eyepiece 10 is reserved for SBIG outline use in this case. The 
SBIG outline can be used to help locate guide stars, centering faint objects and deter-
mining what camera angle is required to put a guide star into the guide chip image. 
The guide chip outline will rotate to the current camera angle if the autoguide calibra-
tion has been done. Depending on your optics you may need to check the Flip Guide 
180° or E/W checkboxes in the eyepiece 10 preference to view the camera rotation 
correctly. Be sure to Save Eyepieces to save your selections.

You can also use this feature when you are not connected to your camera. When you 
first connect the camera information is saved as a preference. Equinox 6 can access 
this information when Equinox Image is running even if it is not connected. If you 
read in a FITS image file the camera rotation record will be used to orient the outline.
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Eyepiece 10 can be used to adjust the SBIG outline to exactly match your images. 
Start by setting the eyepiece adjustment value to 100.0%. Then compare an actual 
image taken with your camera to the SV image. Adjust the eyepiece value to scale 
the SV image to match your actual image. If you have a focal reducer this adjustment 
will be large. If not the adjustment should be smaller.

By running Equinox 6 and Equinox Image together during an imaging session you 
have access to all the scope control features of Equinox 6 with all the camera con-
trols of Equinox Image. However, if you want to do advance planning and guide star 
selection check out AstroImageBrowser (http://homepage.mac.com/astrod/Sites/soft-
ware/astroimagebrowser/aib.html).

While Equinox 6 can get camera information from Equinox Image to use in the 
Scope View window, Equinox Image can access the current scope information and 
object location from Equinox 6. This information is saved in the FITS header of all 
the images you save. Not only do you get this information recorded with the images 
but the FWHM calculation can use this information to give you accurate arcsec val-
ues - even when you read in the file later on. 

You do not have to do anything to initiate this cross application communication. If 
both applications are running the data is passed between them automatically when-
ever needed.  

Equinox Image calculates arcsec values for several functions (Star Profile, Drift 
Trend log, etc.). Your scope’s focal length should be entered from the Image tab. 
However, this should be the effective focal length, not the actual focal length. Every-
thing that is attached to your scope effects the effective focal length, including focus-
ers, filter wheels, focal reducers, and so on. 

To calculate the effective focal length with a particular set up you need to know the 
field of view from one of your images. You may know this from star charts, or if you 
have scaled the Scope View image with eyepiece 10 in Equinox 6 you can measure it 
there (option + drag across the width of the SBIG outline). The astrometry function 
can also calculate an image’s field of view (after alignment and scaling).

Once you know the field of view of your image width, you can calculate the effective 
focal length from the following equation:

FLe = chipWidth * 206.265 * pixelWidth  /  imageFOV

The chipWidth is the width of your SBIG image chip in pixels (binned 1X1), the 
pixelWidth is in microns and the imageFOV is in arcseconds. As an example, my 
chipWidth is 1600 pixels (ST-2000), the pixelWidth is 7.4 microns and I measured an 
image width of 17’ 59” (1079”) with a f/6.3 focal reducer. This gave me an effective 
focal length of 2263mm for my 14” LX200 (focal length 3556mm).
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Drift Scan
Drift Scanning or Time Delayed Integration (TDI) is an imaging method that keeps 
the camera fixed and lets the sky drift across the CCD at sidereal rate (RA scanning) 
or tracks the sky at sidereal rate and drives the scope’s Dec at some rate (Dec scan-
ning). This allows you to take huge images of the sky with long exposure times.  If 
you are unfamiliar with TDI techniques you should read the available literature be-
fore you try this with Equinox Image. 

Equipment

You need a dual processor Mac for best results. While drift scanning your Mac should 
be dedicated to the task and not running any other applications. Color cameras can 
not be used for drift scanning and interline cameras (ST-2000XM) are not suitable be-
cause of their dark current levels. The use of a focal reducer is not recommended.

Camera Setup

Enter your scope’s focal length in the FL text entry box. You must hit the return key 
to register your entry. If you know the required scan rate you can enter it in the Rate 
text box. The Calibration operation will calculate the required scan rate and is the 
preferred method to determine this value if it is not known exactly. 
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Calibration

Drift scanning requires the image CCD to be aligned precisely. The rows must be 
pointing north/south for RA scanning or east/west for Dec scanning. This allows the 
stars to drift up through the CCD on the same column. The calibrate function allows 
you to align your camera and also calculate the correct scan rate. The scan rate is 
the time it takes a star to move from one CCD row to the next. For RA scanning the 
closer you are to a Dec of 0° the better the results.

The calibration function uses the image focus capabilities of Equinox Image. First, 
align your camera as accurately as you can in the correct orientation. If you are RA 
scanning make sure your mount is not tracking. If you are Dec scanning make sure 
your scope is tracking and start the Dec drive. 

From the Image tab take a normal image exposure with a fast exposure time (you 
only want to image the bright stars in the field), Select the Focus checkbox and drag a 
tall, narrow focus rectangle in the image with a bright star near the bottom. The idea 
is that you want the bright star to drift straight up. Hit the Expose button to start the 
focus operation. If a brighter star should drift into the focus area you will have to stop 
the calibration and start over.

Once the focus exposures are being taken open the Drift Scan panel (from the View 
menu) and hit the Calibrate button. The position of the bright star will be calculated 
and used as the start point. As the star drifts up in the focus image the angle will be 
calculated. You need to align the camera so that the angle error is zero or very close 
to zero.

Of course, each time you change the camera orientation you will probably have to 
stop the focus, take a new image and start the calibration over. Once you get the cam-
era accurately aligned let the calibration run for awhile. This will give you a more ac-
curate rate calculation. When you have a good camera alignment and rate calculation 
stop the calibration and save the calibration values. The save button also saves all the 
setup data as preferences. You are now ready to start the drift scan exposure.

Scan Setup

You can enter the desired scan time in minutes and seconds or the total number of 
lines to scan but not both. If you enter zero time and zero lines the scan will run until 
you manually stop it. At the start of a scan the first frame does not receive a consis-
tent exposure time so normally the Drop First Frame checkbox is selected. When 
selected the first frame of image data is not written to the file and the scan timer is 
started at the beginning of the second frame. 

The Lines/File entry allows you to specify the maximum number of lines per file. If 
you enter 0 just one file will be created with the entire scanned image. Otherwise the 
current file will be closed and a new file opened every time the Lines/File number of 
lines have been scanned, including 25 lines of overlap. 
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Select the Display Image checkbox and a 1/4 size image will be displayed. Use this 
to make sure you are recording a good image but it is recommended that you turn this 
off once you have verified the scan as it uses a lot of  CPU processing time.

Scan Update box

The numerical readout in the update box displays the total number of image lines 
(CCD rows) that have been downloaded. The progress bar indicates the percent of 
completion of the scan. If no scan time or lines/scan have been entered, or if the first 
frame is being downloaded and dropped, the progress bar is indeterminate and ani-
mated.

Information box

Pixel arcsec is the field of view of each pixel (height) as determined by the pixel size 
and the scope’s focal length. The width field of view (FOV) is the width of the image 
in arc degrees and minutes. The exposure value is the time it takes for one complete 
frame to be exposed in minutes. This is the time it takes for a star to drift up through 
the entire height of the CCD.

File

When you start a scan a FITS file will be created with the file name preface and loca-
tion that you have specified from the File tab. Once the first frame is past (if you have 
selected to drop it) scan data is written to the file. When the scan is stopped, either 
manually, when the time runs out or when the lines/scan have been recorded, the file 
is closed. A new scan will open a new file. Note that these files can be very large so 
make sure you have selected a disk that has sufficient capacity.

If you have specified a Lines/File value each additional file will have the same file 
name but the file number will be incremented by one.

Dark Frame / Flat Field

Usually a dark frame is not required for drift scan images - hot pixels are averaged 
out over the entire height of the CCD. However, if you have a bad column it can 
show up as a streak along the entire length of the image. Equinox Image can mini-
mize this, but not completely eliminate it. You need to take a normal dark frame at 
the frame exposure time and temperature of your scan. Then use the normal Subtract 
Dark function from the File tab. Equinox image will figure out that the image is a 
drift scan and subtract the appropriate amount from each column pixel in the image. 
You can also process the scanned images with the appropriate flat field image.
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Dec Scan Automation

You can automate Dec scanning with AppleScript and Equinox 6. This functionality 
is primarily used if you have a permanent setup and need to do identical scans ex-
tending over many nights.

You need to set up your scope with the Dec guide speed established (this may be 
difficult with some mounts), the exact scan rate determined and the camera aligned. 
Once this is done an AppleScript can automate multiple Dec scans with several dif-
ferent setup values and different start locations in the sky.

The Dec scanning parameters are established in one or more text files which must be 
located in the Misc folder. Use the sample file as a guide.

SCANRA  = 135.0		  // RA in deg. enter -1.0 for no scope action
SCANDEC = -10.0		  // Dec in deg.
SCOPEDLY= 60.0          // scope move time in seconds
SCANRATE= 0.048694	 // seconds. enter 0.0 to use default
SCANMIN = 0			  // enter 0 for scan line
SCANSEC = 0			  // enter 0 for scan line
SCANLINE= 9000		  // total lines/scan. enter 0 for scan time
SCANFILE= 2400		  // lines per file
SCANDROP= YES		  // drop first frame. enter YES or NO
SCANIMAG= NO		  // display image. enter YES or NO
SCANDEC+= UP		  // dec scanning. enter UP. DN, or NA

The SCANDEC+ parameter tells the scope which direction to move in Dec. The ac-
tual control used is the Equinox Image scope control function, so the control is driven 
by the autoguide port connection in the SBIG camera. The SCANRA and SCANDEC 
parameters are sent to Equinox 6 so the goto command is via the serial scope connec-
tion. The sequence is: 

1) goto the RA and Dec (via Equinox 6 with SCOPEDLY seconds delay) 
2) drive the Dec control (Up or Down via autoguide port) while taking the scan 
3) once the scan is complete move the scope back to the start RA and Dec 
4) then repeat. 

You can establish many different parameter files and from the AppleScript select the 
ones to use. 

There are many ways to design an automation AppleScript. The following sample 
starts both Equinox 6 (you must have version 6.5.0+) and Equinox Image. It then tells 
Equinox Image to connect to the camera and Equinox 6 to connect to scope number 
1. After a minute (return 60) it then takes three scans using setup file 1, three scans 
using setup file 2, and then shuts everything down. To use an Idle handler like this 
sample the AppleScript should be saved as a “Stay Open” application.
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property mycount : 0
set mycount to 0
run application “Equinox 6”
run application “Equinox Image”
on idle
	 set mycount to mycount + 1
	 if mycount = 1 then
		  tell application “Equinox Image”
			   set drift Cmd to “CONNECT”
		  end tell
		  tell application “Equinox 6”
			   set scope Connect to 1
		  end tell
		  return 60
	 else if mycount < 5 then
		  tell application “Equinox Image”
			   set drift Cmd to “ScanSetup1.txt”
		  end tell
	 else if mycount < 8 then
		  tell application “Equinox Image”
			   set drift Cmd to “ScanSetup2.txt”
		  end tell
	 else
		  tell application “Equinox Image”
			   set drift Cmd to “STOP”
		  end tell
		  tell application “Equinox Image”
			   quit
		  end tell
		  tell application “Equinox 6”
			   quit
		  end tell
		  quit
	 end if
	 return 300
end idle

When designing your AppleScript you have to be very careful about the timing. You 
do not want to start a new scan before the previous one has finished or start driving 
the scope to a new location in the middle of a scan. It will probably take several at-
tempts and a few bad scans before you get everything timed just right and working 
the way you want.
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Differential Deflection
Differential deflection or flexure refers to the optical axis changes that can occur 
between the main imaging scope and a separate guide scope. These variations are 
caused by gravity and the changing position of the scope. 

In order to correct for this effect you need two SBIG cameras (unless you have a new 
STX camera). However, one of the cameras can be a single chip camera like the ST-
402ME. A remote guide head can be used with the guide scope camera but it can not 
replace the camera itself. You will also have to run two instances of Equinox Image at 
the same time on your Mac. You can do this by duplicating the entire Equinox Image 
folder in some other directory and then launching the two apps separately.

The main imaging camera will use its internal guide chip to detect the position of 
a faint star within the guide frame. The guide exposure time can be seconds long, 
whatever is required to calibrate and guide on this faint star. This guiding action will 
be used to send flexure correction values to the second camera doing the fast guiding 
on the guide scope. 

The camera on the guide scope will calibrate and guide on a much brighter star and 
can have a much shorter guide exposure time and a faster guide frequency. It is this 
camera that will connect to your mount’s autoguide port - the imaging camera will 
not have a connection to the autoguide port. 

In the Connect tab of the SBIG panel you will see an “Image” checkbox appear once 
two instances of Equinox Image are running. You need to tell these two instances 
which one of them is connected to the imaging camera and will be passing flexure 
corrections to the other instance. You do this by checking the Image checkbox only in 
the Equinox Image instance that is connected to the imaging camera. You must check 
this box before you calibrate either camera.

Once you have calibrated on both guide stars in the two cameras you can 
start guiding in both cameras. Once the guiding has stabilized you can be-
gin taking your image exposures. Note that flexure corrections will prob-
ably not be in the same direction as your scope’s normal drift, so use the 
Dec +- checkboxes with caution.

The differential deflection correction values are sent by the imaging cam-
era’s Equinox Image instance to the guide camera’s Equinox Image in-
stance. The guide camera’s instance uses these values to offset the position 
of its guide control point to compensate for the flexure. This control point 
is normally in the center of the guide frame. If you have a lot of flexure 
it is possible that the guide control point will shift right out of the guide 
frame. In the Guide Size popup menu a new “Flex” size has been added. 
If the Large guide size is not big enough this larger Flex guide frame will 
slow down the guiding frequency but it should be large enough to prevent 
the control point from shifting out of the frame.


